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Հարգելի՛ ուսուցիչ 

 

Խորհուրդ ենք տալիս առաջադրանքները կատարել ըստ հերթականության: 

Ուշադիր կարդացե՛ք յուրաքանչյուր առաջադրանք: Եթե չի հաջողվում որևէ առաջադրանքի 

անմիջապես պատասխանել, ժամանակը խնայելու նպատակով կարող եք դրան 

անդրադառնալ ավելի ուշ: 

Թեստ-գրքույկի  էջերի  դատարկ  մասերը  կարող  եք  օգտագործել  սևագրության  

համար: 

 

 

 



Microsoft Word փաստաթղթի կառուցվածքի մեջ ինչպե՞ս է ազդում ձեռքով 

տեղադրված Page Break-ը բովանդակության դասավորության և հաջորդական 

բաժինների փոփոխությունների վրա։ 
 

1) Page Break-ը ավարտում է ընթացիկ պարագրաֆը և պարտադիր ձևափոխում 

է այն Heading 1 ոճով 

2) Page Break-ը ապահովում է անցում նոր էջ, բայց չի ստեղծում նոր բաժին 

(Section) և թույլ չի տալիս փոխել հաջորդ էջի կողմնորոշումը կամ եզրերը 

3) Page Break-ը ստեղծում է նոր բաժին (Section) և թույլ է տալիս փոխել էջի 

կողմնորոշումը կամ եզրերը հենց հաջորդ էջից 

4) Page Break-ը տեղափոխում է տեքստը հաջորդ էջ՝ առանց պահպանելու 

ընթացիկ բաժնի (Section) բոլոր ձևաչափման կանոնները 

 

 

Ընտրել Excel-ի Goal Seek գործիքի աշխատանքի ճիշտ նկարագրությունը։ 
 

1) Goal Seek-ը գտնում է միաժամանակ մի քանի մուտքային փոփոխականների 

օպտիմալ համադրությունը 

2) Goal Seek-ը միաժամանակ փոխում է բանաձևը և նպատակային բջջի արժեքը 

որպեսզի ստանա ցանկալի արդյունքը 

3) Goal Seek-ը ավտոմատ փոխում է բանաձևը, որպեսզի ստանա ցանկալի 

արդյունքը 

4) Goal Seek-ը փոխում է միայն նշված բջջի արժեքը, մինչև բանաձևի արդյունքը 

հասնի օգտատիրոջ սահմանած արժեքին 

 

 

Ի՞նչ արդյունք կտա բանաձևը Microsoft Excel ծրագրում։ 
 

=COUNTA(A1:A5) 

եթե արժեքներն են՝ 

A1=12, A2="Hello", A3=7, A4="", A5="World" 

1) 5 

2) 2 

3) 3 

4) 4  
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Ի՞նչն է բնորոշ Backend ծրագրավորմանը։ 
 

1) Վեբ կայքի գունային սխեմայի և դիզայնի ընտրությունը 

2) Պատկերների և անիմացիաների լավարկումը 

3) Օգտագործողի ինտերֆեյսի և գրաֆիկական ձևավորման ստեղծումը 

4) Տվյալների մշակումը, բազաների կառավարումը և սերվերի կողմից 

տրամաբանության իրականացումը 

 

Ի՞նչ հիմնական գաղափար է ընկած RAG (Retrieval-Augmented Generation)  

                մոդելի հիմքում։ 
 

1) Մոդելը պատասխանի գեներացման համար օգտագործում է սեփական 

տեղեկատվությունը առանց դիմելու արտաքին ներմուծված աղբյուրներին  

2) Մոդելը օգտագործվում է միայն պատկերների ճանաչման համար  

3) Մոդելը ստեղծում է պատահական տեքստ առանց արտաքին տվյալների 

4) Մոդելը նախ որոնում է համապատասխան տեղեկատվություն բազայում, 

ապա ստեղծում պատասխանը այդ տվյալների հիման վրա 

 

Ո՞ր Bits per Channel (RGB) ռեժիմում են Adobe Photoshop ծրագրի Image > 

Adjustments մենյուի Color Balance, Shadows/Highlights հրամաններ դառնում 

անհասանելի (greyed out): 
 

1) 16 Bits/Channel  

2) 24 Bits/Channel  

3) 8 Bits/Channel 

4) 32 Bits/Channel 

 

Ո՞րն է Slice Tool-ի հիմնական գործառույթը Adobe Photoshop ծրագրում: 
 

1) Նկարը բաժանում է հատվածների՝ թույլ տալով յուրաքանչյուր հատվածի 

համար կիրառել տարբեր գունային ռեժիմներ (RGB/CMYK): 

2) Նկարը բաժանում է հատվածների՝ հնարավորություն տալով դրանք 

արտահանել որպես առանձին պատկերային ֆայլեր: 

3) Նկարից առանձնացնում է հատվածներ ըստ գույների՝ ֆոնը հեռացնելու 

համար:  

4) Նշված հատվածը կտրում և ավտոմատ տեղափոխում է նոր շերտի վրա՝ 

հետագա խմբագրման համար: 
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Եթե Canvas Size հրամանով մեծացրել եք նկարի չափսերը, ո՞ր հրամանը թույլ կտա 

նշելուց հետո դատարկ հատվածները լրացնել՝ վերլուծելով և կրկնելով շրջակա 

պիքսելները: 
 

1) Dodge Fill  

2) Magic Wand Tool 

3) Paint Bucket Tool 

4) Content-Aware Fill 

 

Ո՞րն է Layer Mask-ի և Clipping Mask-ի հիմնական տարբերությունը  

                Adobe Photoshop ծրագրում: 

1) Clipping Mask-ը ջնջում է պիքսելները, իսկ Layer Mask-ը պահպանում է 

դրանք: 

2) Layer Mask-ը լուսանկարների հետ է աշխատում, իսկ Clipping Mask-ը՝ միայն 

տեքստային շերտերի։ 

3) Layer Mask-ը կիրառվում է միայն վեկտորային օբյեկտների վրա, իսկ 

Clipping Mask-ը՝ ռաստերային: 

4) Layer Mask-ը օգտագործում է սև-սպիտակ գույների թափանցիկության 

համար, իսկ Clipping Mask-ը օգտագործում է ներքևի շերտի ձևը և 

թափանցիկությունը: 

 

Ո՞ր հրամանն է Adobe Photoshop ծրագրում անհրաժեշտ նախապես կիրառել 

շերտի վրա, որպեսզի հնարավոր լինի այն բազմակի անգամ փոքրացնել և 

մեծացնել՝ առանց պատկերի որակը կորցնելու: 

1) Convert to Smart Object 

2) Merge Visible  

3) Flatten Visible 

4) Rasterize Layer Object 

 

Ի՞նչ է տեղի ունենում Adobe Illustrator ծրագրում օբյեկտի հետ, երբ կիրառվում է 

                Expand Appearance հրամանը: 

1) Օբյեկտի բոլոր առանձին մասերը միաձուլվում են՝ դառնալով մեկ 

ընդհանուր անբաժանելի եզրագիծ  

2) Օբյեկտի չափսերը ավտոմատ մեծանում են՝ հարմարեցվելով 

աշխատանքային տիրույթի սահմաններին  

3) Օբյեկտը ամբողջությամբ վերածվում է ռաստերային պատկերի՝ կորցնելով 

իր վեկտորային հատկությունները 

4) Օբյեկտի էֆեկտներն ու եզրագծերը տրոհվում են՝ վերածվելով առանձին 

խմբագրելի վեկտորային ձևերի 
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Adobe Illustrator ծրագրում ո՞ր ֆունկցիան է թույլ տալիս ռաստերային պատկերը  

               ավտոմատ վերածել վեկտորային գծերի: 

1) Clipping Image 

2) Flatten Trace  

3) Rasterize Image 

4) Image Trace 

 

Ո՞րն է Adobe Illustrator ծրագրում Blend Tool-ի և Gradient Tool-ի հիմնական 

              տարբերությունը։ 

1) Gradient Tool-ը կիրառվում է Bitmap օբյեկտների վրա, իսկ Blend Tool-ը՝ HSL 

օբյեկտների վրա 

2) Gradient Tool-ը ստեղծում է գունային անցում մեկ օբյեկտի ներսում, իսկ 

Blend Tool-ը՝ երկու և ավելի օբյեկտների միջև 

3) Gradient Tool-ը աշխատում է միայն ռաստերային նկարների վրա, իսկ Blend 

Tool-ը՝ վեկտորային օբյեկտների վրա 

4) Gradient Tool-ը փոփոխում է օբյեկտի երկրաչափական ձևը, իսկ Blend Tool-

ը՝ միայն գույնը 

 

Adobe Illustrator ծրագրում ի՞նչ ֆունկցիա է կատարում Eyedropper Tool-ը: 

1) Ընդօրինակում է օբյեկտի ձևավորման հատկությունները՝ գույն, եզրագիծ, 

էֆեկտներ և կիրառում դրանք մեկ այլ օբյեկտի վրա  

2) Հաշվարկում է նշված հատվածի պիքսելների միջին գունային արժեքը՝ 

նկարի որակը բարելավելու համար  

3) Վերցնում է միայն օբյեկտի գույնի կոդը (RGB/CMYK)՝ անտեսելով 

եզրագծերը և էֆեկտները 

4) Խառնում է երկու գույները իրար՝ ստեղծելով նոր երանգ 

 

Ինչպե՞ս կարելի է միացնել երկու առանձին բաց եզրակետերը՝ դրանք դարձնելով 

մեկ միասնական փակ կամ շարունակական ուղի Adobe Illustrator ծրագրում: 

1) Object > Merge 

2) Object > Compound Path > Make 

3) Object > Group  

4) Object > Path > Join 
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Աքսոնոմետրիկ պրոյեկցիայի ո՞ր տեսակի դեպքում են առանցքներից երկուսի 

               մասշտաբային գործակիցները հավասար, իսկ երրորդինը՝ դրանցից տարբեր: 
 

1) Տրիմետրիկ պրոյեկցիա 

2) Կովալյեր պրոյեկցիա 

3) Իզոմետրիկ պրոյեկցիա 

4) Դիմետրիկ պրոյեկցիա 

 

3D գրաֆիկայում ո՞ր գործընթացն է պատասխանատու մաթեմատիկական  

                մոդելը (Wireframe) վերջնական պիքսելային պատկերի (Image/Video)  

                վերածելու համար։ 
 

1) Texture Baking 

2) Polygon Optimization 

3) Vectorization 

4) Rendering 

 

Ի՞նչ է անում Clip Content ֆունկցիան Figma ծրագրում: 
 

1) Frame-ի տարբեր պարունակություն ունեցող շերտեր միավորում է մեկ 

շերտի մեջ 

2) Արգելափակում է Frame-ի չափսերի փոփոխությունը 

3) Ավտոմատ կերպով կտրում է Frame-ի պարունակությունը՝ դարձնելով այն 

շրջանաձև տեսքի 

4) Թաքցնում է Frame-ի սահմաններից դուրս եկող ցանկացած հատված 

 

Figma ծրագրում ի՞նչ տարբերություն կա Group (Ctrl+G) և Frame (Ctrl+Alt+G)  

                հասկացությունների միջև: 
 

1) Group-ը թույլ է տալիս ստեղծել Layout Grid-եր և կառավարել ադապտիվ 

դիզայնը, իսկ Frame-ը նախատեսված է բացառապես ստատիկ օբյեկտները 

պարզապես իրար կպցնելու համար  

2) Frame-ը օգտագործվում է միայն որպես էկրան Prototype ռեժիմի համար և 

չի կարող դրվել մեկ այլ Frame-ի ներսում, իսկ Group-ը՝ կարող է  

3) Group-ը ավտոմատ կերպով միաձուլում է բոլոր շերտերը մեկ ռաստերային 

պատկերի, իսկ Frame-ը թույլ է տալիս պահպանել դրանց վեկտորային 

կառուցվածքը խմբագրման համար 

4) Frame-ը հանդիսանում է ֆունկցիոնալ տարածք, որն ունի անկախ 

սեփական հատկություններ, իսկ Group-ի սահմանները որոշվում են միայն 

իր մեջ գտնվող օբյեկտներով 
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Ի՞նչ արժեք կարտածի հետևյալ Python կոդը: 

a = 56   

b = 3   

result = a << b   

print(result) 
 

1) 448 

2) 668 

3) 168 

4) 228 

 

 

 

 

Տրվածներից ո՞ր 3 պնդումներն են ճիշտ։Նշել դրանց համարները։ (3 միավոր) 

1. UI դիզայնը զբաղվում է տվյալների բազայում օգտատերերի անձնական 

տվյալների պահպանման ալգորիթմներով։  

2. Որակական հետազոտությունը կենտրոնանում է գնորդների ֆինանսական 

եկամուտների հաշվարկման վրա։  

3. Adobe Photoshop ծրագրում Smart Object-ի վերածված շերտը պահպանում է 

ֆայլի օրիգինալ տվյալները՝ թույլ տալով բազմակի անգամ փոքրացնել և 

մեծացնել այն առանց որակի կորստի։ 

4. Որակական հետազոտության (Qualitative Research) հիմնական նպատակը 

կայքի HTML/CSS կոդի սխալների հայտնաբերումն է։ 

5. A/B թեստավորումը նշանակում է կայքի A տարբերակի ստուգում Android 

համակարգով, իսկ B տարբերակի ստուգում՝ iOS համակարգով։  

6. Adobe Illustrator ծրագրում Perspective Selection Tool-ը թույլ է տալիս 

օբյեկտները տեղաշարժել հեռանկարային (Perspective) ցանցի վրա: 

7. Adobe Illustrator ծրագրում Live Paint Bucket-ը ավտոմատ ստեղծում է 

Clipping Mask 

8. Adobe Illustrator ծրագրում  Shape Builder Tool-ը թույլ է տալիս միավորել 

օբյեկտները: 

9. Usability Testing-ի հիմնական նպատակը կայքի գունային գամմայի 

գեղագիտական գնահատումն է արվեստի տեսանկյունից։ 
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Տրվածներից ո՞ր 3 պնդումներն են ճիշտ։Նշել դրանց համարները։ (3 միավոր) 

1. Տեքստի հիերարխիան ենթադրում է, որ բոլոր տեքստերը պետք է լինեն 

նույն չափսի և գույնի՝ դիզայնի պարզությունը պահպանելու համար։ 

2. A/B թեստավորումը իրականացվում է A – գրաֆիկական և B – տեքստային 

մասերի աշխատանքը առանձին ստուգելու համար։ 

3. Wireframe-ը կայքի կամ հավելվածի սկզբնական նախագիծն է, որտեղ նշվում 

են էլեմենտների դիրքերը՝ առանց դիզայնի գունային մանրամասների։ 

4. Agile-Sprint-ը համակարգչային հատուկ ծրագիր է, որը նախատեսված է 

վերջնական դիզայնը մշակելու համար։ 

5. UI դիզայնում 8px ցանցային համակարգը (Grid system) օգտագործվում է 

միայն տառաչափերը որոշելու համար։  

6. Figma-ում Plugin-ները խթանում են դիզայնի գործընթացը՝ ծրագրին 

ավելացնելով նոր հնարավորություններ, գործառույթներ և 

ավտոմատացում։ 

7. Տեքստի հիերարխիան ձևավորվում է միայն կայքի սերվերային (Back-end) 

փուլում՝ Markdown ծրագրավորման լեզվի միջոցով։ 

8. Wireframe-ը ներկայացնում է նախագծի վերջնական տեսքը՝ ներառյալ 

բրենդային գույները, ոճերը և բոլոր լուսանկարները։ 

9. Prototype-ը դիզայնի ինտերակտիվ մոդելն է, որը թույլ է տալիս 

սիմուլյացնել օգտատիրոջ գործողությունները, էջերի անցումները և 

անիմացիաները՝ նախքան ծրագրավորումը։ 

 

 

Նշվածներից ո՞ր 3 պնդումներն են ճիշտ Python-ի կլաս-ի(Classes) և Objects  

              վերաբերյալ: (3 միավոր) 

1. Օբյեկտը կոնկրետ օրինակ (instance) է այդ կլասից։ 

2. Կլասի ներսում ֆունկցիաները կոչվում են մեթոդներ։ 

3. Կլասը ձևանմուշ է (template), որով ստեղծվում են օբյեկտներ։ 

4. Օբյեկտները չեն կարող ունենալ տարբեր արժեքներ նույն ատրիբուտի 

համար։  

5. Կլասը չի կարող պարունակել տվյալներ (ատրիբուտներ)։  

6. Բոլոր օբյեկտները պարտադիր ունեն նույն վարքագիծը։  

7. Կլասները հնարավոր չէ սահմանել դատարկ (pass հրամանով)։  

8. Կլասի անունները պետք է լինեն ամբողջությամբ փոքրատառ։  

9. Օբյեկտը հնարավոր չէ ստեղծել առանց պարամետրերի։  
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ վեբ ծրագրավորման (Advanced Web  

               Development) վերաբերյալ։ (3 միավոր) 

1. SQL հարցումները կիրառվում են միայն frontend-ում։  

2. HTML լեզուն հիմնականում նախատեսված է BackEnd ծրագրերի մշակման 

համար։ 

3. REST API-ն (Representational State Transfer) օգտագործվում է սերվերի և 

հաճախորդի միջև տվյալների փոխանակման համար։ 

4. AJAX տեխնոլոգիան օգտագործվում է բացառապես CSS ոճերը դինամիկ 

կերպով փոփոխելու համար։ 

5. JSON ձևաչափը (JavaScript Object Notation) օգտագործվում է տվյալների 

կառուցվածքային փոխանակման համար։ 

6. Framework-ները (օր.՝ Django, React, Angular) արագացնում են վեբ 

հավելվածների մշակումը։ 

7. CSS-ը համարվում է backend լեզու։  

8. Node.js-ը նախատեսված է միայն frontend ծրագրավորման համար։ 

9. API ինտերֆեյսները թույլ չեն տալիս ծրագրերին հաղորդակցվել միմյանց 

հետ։ 

 

 

Նշվածներից ո՞ր 3 պնդումներն են ճիշտ կիրառական հավելվածների ստեղծման  

              միջոցների վերաբերյալ։ Նշել դրանց համարները։ (3 միավոր) 

 

1. Կիրառական հավելվածների մշակումը պահանջում է միայն 

ծրագրավորման հմտություններ։  

2. Կիրառական հավելվածը նույնն է, ինչ օպերացիոն համակարգը։  

3. Կիրառական հավելվածները միշտ աշխատում են միայն օֆլայն (առանց 

ինտերնետի)։  

4. Հավելված ստեղծելու համար պարտադիր է ունենալ օպերացիոն 

համակարգի աղբյուրային կոդը։  

5. IDE միջավայրերը չեն ապահովում ծրագրի փորձարկում։ 

6. Կիրառական հավելվածը նախատեսված է կոնկրետ գործնական խնդրի 

կամ ծառայության իրականացման համար։ 

7. Կիրառական հավելվածների ստեղծման համար կարող են օգտագործվել 

միջավայրեր, ինչպիսիք են՝ Visual Studio, PyCharm, Eclipse։ 

8. Կիրառական հավելվածները լինում են BackEnd, WithoutEnd, FrontEnd։  

9. Կիրառական հավելվածների մշակման գործընթացում կիրառվում են 

ինտերֆեյսների և տվյալների բազաների ինտեգրում։ 
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ գունային համադրությունների  

               վերաբերյալ:  (3 միավոր) 

1. Achromatic համադրությունը ներառում է գունային շրջանակի բոլոր տաք 

գույները։ 

2. Complementary գույները գունային շրջանակի վրա գտնվում են 90° անկյան 

տակ։ 

3. Analogous գույները գունային շրջանակում գտնվում են միմյանց կողքի։ 

4. Monochromatic համադրությունը պարունակում է միմյանց հակադիր 

գույներ։ 

5. Tetradic համադրությունը կազմված է ընդամենը երեք գույնից։ 

6. Split-Complementary գույները կազմվում են մեկ գույնի և նրա հակադիրի 

երկու հարևան գույներից։ 

7. Tonal գույները կազմված են միայն ամենավառ և հագեցած երանգներից։ 

8. Square սխեման միավորում է իրար կողք գտնվող չորս գույները։ 

9. Triadic գույները հավասարաչափ տեղադրված են գունային շրջանակում։ 

 

 

 

Նշվածներից ո՞ր 3 պնդումներն են ճիշտ HTML/CSS-ի վերաբերյալ։ (3 միավոր) 
 

1. CSS-ի type հատկությունը փոխում է տառատեսակի անվանումը։ 

2. CSS-ի display: block; հատկությունը տարրը դարձնում է inline և թույլ է տալիս 

դասավորել նույն տողում։ 

3. HTML-ի <ol> թեգը օգտագործվում է համարակալված ցուցակներ ստեղծելու 

համար։ 

4. CSS-ի font-size հատկությունը փոխում է տառատեսակի գույնը։ 

5. HTML-ի <input type="password"> թեգը թաքցնում է մուտքագրվող նիշերը։ 

6. CSS-ի margin հատկությունը ավելացնում է տարածություն օբյեկտի 

սահմաններից ներս։ 

7. HTML-ի <br> թեգը օգտագործվում է տեքստը թավ դարձնելու համար։ 

8. CSS-ի text-decoration հատկությունը սահմանում է տեքստի գծային 

ձևավորումը: 

9. HTML-ի <head>  թեգը պարունակում է էջի հիմնական տեսանելի 

բովանդակությունը։ 
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ HTML/CSS-ի վերաբերյալ: (3 միավոր) 

1. HTML-ի <hr> թեգը ստեղծում է հիպերհղում դեպի այլ էջ։ 

2. CSS-ի background-image հատկությունը փոխում է տեքստի գույնը։ 

3. CSS-ի border-radius հատկությունը օգտագործվում է տարրի անկյունները 

կլորացնելու համար։ 

4. HTML-ի <span> թեգը բլոկային տարր է և միշտ սկսվում է նոր տողից: 

5. CSS-ի font-family հատկությունը որոշում է տեքստի տառատեսակը✅ 

6. CSS-ի position: fixed; հատկությունը ֆիքսում է տարրը էկրանի վրա՝ անկախ 

էջը թերթելուց։ 

7. CSS-ի z-index հատկությունը փոխում է օբյեկտի թափանցիկությունը։ 

8. HTML-ի <link> թեգը օգտագործվում է էջում նկար տեղադրելու համար։ 

9. CSS-ի width հատկությունը փոխում է օբյեկտի գունային ֆոնը։ 

 

 

 

Նշված տարբերակներից ո՞ր 3-ն են ճիշտ CSS-ում h1 վերնագիրը կենտրոնացնելու, 

2px հաստությամբ կապույտ հոծ եզրագիծ և կապույտ տեքստ ստանալու համար։ 

Նշել դրանց համարները։ (3 միավոր) 

1. h1 { text-align: center; border: 2px blue; color: blue; } 

2. h1 { font-align: center; border: 2px solid blue; text: blue; } 

3. h1 { text-align: center; border: 2px solid blue; color: blue; } 

4. h1 { align: center; border: 2px solid blue; font-color: blue; } 

5. h1 { text-align: center; border: 2px solid blue; color: rgb(0, 0, 255); } 

6. h1 { text-position: center; border: 2px solid blue; color: #0000FF; } 

7. h1 { text-align: center; border: 2px solid #0000FF; color: #0000FF; } 

8. h1 { text-align: middle; border-size: 2px; border-color: blue; color: blue; } 

9. h1 { text-align: center; border-weight: 2px; color: blue; } 
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ Python-ի պայմանական  

       օպերատորների (if, elif, else) վերաբերյալ։ (3 միավոր) 

1. Եթե մի քանի պայման ճշմարիտ է, Python-ը կատարում է բոլոր ճշմարիտ 

բլոկները։ 

2. elif կարող է օգտագործվել առանց նախորդ if հրամանի։  

3. Եթե if պայմանը կեղծ է (False), ապա, առկայության դեպքում, else բլոկը 

միշտ կկատարվի։ 

4. else պետք է պարտադիր պարունակի պայման։ 

5. Պայմանական հրամանները չեն կարող տեղադրվել միմյանց ներսում։  

6. Պայմանական հրամանը կարող է օգտագործվել միայն թվային արժեքների 

համար։ 

7. if հրամանը չի կարող օգտագործվել առանց else-ի։ 

8. if հրամանը օգտագործվում է, երբ պետք է ստուգվի որոշ պայման։ 

9. elif նշանակում է “else if” և օգտագործվում է՝ երբ պետք է ստուգվի 

լրացուցիչ պայման։ 
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